User’s Guide

INA232EVM, INA234EVM and INA236EVM

wip TEXAS INSTRUMENTS

ABSTRACT

This user’s guide describes the characteristics, operation, and use of the INA232, INA234 and INA236
evaluation modules (EVMs). These EVMs are designed to evaluate the performance of the INA232, INA234 and
INA236. Throughout this document, the terms evaluation board, evaluation module, and EVM are synonymous
with the INA232EVM, INA234EVM and INA236EVM. This document includes a schematic, reference printed
circuit board (PCB) layouts, and a complete bill of materials (BOM).
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1 Trademarks

Chrome™ is a trademark of Google LLC.

Firefox™ is a trademark of Mozilla Foundation.

All trademarks are the property of their respective owners.
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2 Overview

The INA23x devices are digital power monitors with integrated 16-bit (INA232, INA236) and 12-bit (INA234)
delta-sigma ADCs specifically designed for current-sensing applications. The devices can measure a selectable
full-scale differential input of £81.92 mV or +20.48 mV across the shunt with common-mode voltage support
from —-0.3 V to +48 V (-0.3 V to +28 V for INA234). The built-in digital accumulation calculates average power
and current if calibration register is programmed. The INA23x devices also have built-in diagnostics to indicate
system health accessible through a digital output pin, ALERT. The output can be interfaced with a multitude of
micro controllers (MCUs) with a standard 12C interface.

Table 2-1. Device Summary

DIGITAL ADC MAX GAIN MAX OFFSET
PRODUCT PROTOCOL RESOLUTION ERROR VOLTAGE
INA232 12C 16-bit 0.25% +20 pv
INA234 12C 12-bit 0.5% +100 pv
INA236 12C 16-bit 0.1% 5 v

2.1 Kit Contents

Table 2-2 lists the contents of the EVM kit. Contact the nearest Texas Instruments Product Information Center if
any component is missing.

Table 2-2. Kit Contents
ITEM QUANTITY

INA232EVM, INA234EVM OR 1
INA236EVM board

Note that this EVM requires the Tl Sensor Control Board (SCB), which is sold separately.
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2.2 Related Documentation From Texas Instruments

This user's guide is available from the Tl website under literature number SBOU264. Any letter appended to the
literature number corresponds to the document revision that is current at the time of the writing of this document.
Newer revisions are available from www.ti.com or the Texas Instruments' Literature Response Center at (800)
477-8924 or the Product Information Center at (972) 644-5580. When ordering, identify the document by both
title and literature number. Table 2-3 lists documentation related to the EVM. Click the links in Table 2-3 for
further information. The device name links to the product web folder on www.ti.com. The literature number links
to the document PDF.

Table 2-3. Related Documentation

DOCUMENT LITERATURE
DOCUMENT TITLE NUMBER
INA232 data sheet SBOSAA2
INA234 data sheet SBOS844
INA236 data sheet SBOSA81

3 Hardware

The EVM is an easy-to-use platform for evaluating the main features and performance of the INA23x. The EVM
supports current measurements up to 10 amps, and includes a graphical user interface (GUI) used to read and
write device registers as well as view and save results data.

The EVM is intended to provide basic functional evaluation of the devices. The layout is not intended to be a
model for the target circuit, nor is it laid out for electromagnetic compatibility (EMC) testing. The EVM consists of
two printed circuit boards (PCBs). The larger PCB is referred to as the EVM, and has either the INA23x installed.
The smaller PCB is referred to as the SCB Controller, and is used to interface the EVM with the GUI.

3.1 Features

» GUI support to read and write device registers as well as view and save results data
* EVM detached from SCB for custom use cases
» Conveniently powered from a common micro-USB connector through the SCB
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4 Operation
4.1 Quick Start Setup

The following instructions describe how to set up and use the EVM.

1. Purchase an SCB if you do not already have one.
2. Download this driver and install it as an administrator: https://www.ti.com/lit/zip/sbac253.
3. Attach the EVM to the SCB Controller as shown in Figure 4-1.
a. Refer to Figure 4-2 when connecting multiple EVMs of the same type together.
4. Connect the EVM to a PC using the provided USB cable.
a. Insert the micro USB cable into the SCB Controller onboard USB receptacle J2.
b. Plug the other end of the USB cable into a PC.
5. Click here to access the GUI in either the Chrome or Firefox browser.
6. Connect the GND reference of the external system to the GND node of the EVM (pin 1 of J1).
7. Provide a differential input voltage signal to the IN+ and IN— nodes by connecting the signal leads to J1 pin 5
or 6 and J1 pin 3 or 4 on the EVM as explained in Section 4.2.3.

4.2 EVM Operation
To use the EVM with the SCB Controller (sold separately), connect the EVM as shown in Figure 4-1.
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Figure 4-1. EVM Connected to SCB Controller

If using multiple EVMs, connect them as shown in Figure 4-2. Make sure to use a different chip address for each
device. The GUI only supports one EVM/device type at a time.
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Figure 4-2. Multiple EVMs Connected to SCB Controller

4.2.1 Setup
4.2.1.1 Driver Installation

Download and install this driver: https://www.ti.com/lit/zip/sbac253. This is a one-time step per computer. Unzip
the folder and run the .exe file with administrator privileges.

4.2.1.2 Firmware

Firmware updates will be pushed through the GUI (requires previous driver to be installed). Downloaded offline
GUIs will only update the SCB Controller with the latest firmware available at the time of download. To check for
the latest GUI or Firmware updates, launch the GUI from the web browser.

4.2.1.2.1 Firmware Debug

If the firmware must be manually reinstalled for any reason, follow these steps to reinstall the firmware. Make

sure the EVM is connected to the SCB.

1. First, see if the GUI can program the firmware manually.

a. Plug in the SCB controller to the PC.

b. Launch the GUI.

c. ltis possible that the MCU has already entered DFU mode. If so, the GUI may notify you and try to
update the firmware to the latest version.

d. Ifit does not update automatically, go to File > Program Device...

2. If that does not work (or if the Program Device button is grayed out), manually configure the MCU on the
SCB Controller to be in Device Firmware Update (DFU) Mode. This can be done through either of the below
methods with the SCB Controller powered on:

a. Through software:

» For safety, turn off and disconnect all load sources and external voltages.
+ Send the command 'bsl' on the SCB's USB Serial (COM) port.
b. Though hardware:
» While shorting the two test points labeled "DFU" (shown in Figure 4-3) with a pair of tweezers (or
wire), press and release the RESET button.
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Figure 4-3. Test Points Used to Enter DFU Mode Manually
With the MCU in DFU mode, the firmware can now be uploaded through the method outlined in Step 1.
4.2.1.3 GUI Setup and Connection
Click here to access the GUI through either the Chrome™ or Firefox™ browser.
4.2.1.3.1 Initial Setup

To set up the GUI the first time:

1. Make sure that the previously mentioned driver was installed successfully to ensure that everything works
properly and that the GUI can update the EVM firmware, if necessary.

2. Check to make sure the EVM/SCB Controller unit is plugged into the PC, then go to the previously-provided
GUI link.

3. Click the GUI Composer application (Figure 4-4) to launch the GUI from the web browser.
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Figure 4-4. GUI Composer Application

a. Follow the prompts to download the T/ Cloud Agent and browser extension shown in Figure 4-5 for the
first-time GUI Composer setup. These prompts will appear after you close the README.md dialog.

Figure 4-5. Tl Cloud Agent

4. Optionally, click the ¥ icon in the GUI Composer application (Figure 4-4) and follow the prompts to
download the GUI for offline use.

4.2.1.3.2 GUI to EVM Connection

To operate the GUI, follow these steps:

1. Connect to and launch the GUI as described in Section 4.2.1.3.1.

2. Check to make sure that the EVM connected to the GUI, then close the README.md file page to initiate the
connection. If successful, the Hardware Connected message should be visible near the bottom-left corner
of the GUI as in Figure 4-6.
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A& GD a COM7:115200 Hardware Connected.

Figure 4-6. Hardware Connected

a. A green indicator with the device type and the text DEVICE CONNECTED should also be visible near
the top-left of the GUI window, as shown in Figure 4-7.

DEVICE CONNECTED

® |[NA236

Figure 4-7. Device Connected
b. If Hardware Connected and DEVICE CONNECTED do not show in the GUI, check the different
hardware COM ports under Options >> Serial Port, as shown in Figure 4-8.

Options

T, Serial Port ...

Figure 4-8. Change Serial Port
c. If the hardware still does not connect, make sure you are using the correct GUI/EVM combination.
i. If you are using the correct GUI/EVM combination, you may need to reprogram the firmware of the
SCB, as described in Firmware Debug.
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4.2.2 GUI Operation

Set up, launch, and connect the GUI to the EVM per Section 4.2.1.3. Refer to the sections below for a
description on how to use each page of the GUI.

4.2.2.1 Homepage Tab

The GUI starts out on the homepage tab. Click the fr (Home) icon on the menu to the left to return to the
homepage tab at any time.

From the homepage, you can easily confirm successful GUI to EVM connection (see Section 4.2.1.3.2), as well
as access helpful resources through the buttons on the bottom (see Figure 4-9).

B £ & il -
Fupctiona[ User Guide Datasheet Schematic E2E Forum
Diagram

Figure 4-9. Home Tab Links

4.2.2.2 Configuration Tab
To do the initial setup for each connected EVM, click the 3 (Configuration) icon on the menu to the left. Figure
4-10 shows an example of the configuration tool, which may change based on the device connected.

Number of EVMs: 2 EVMs v Selected EVM: EVM 1 v

EVM 1

Hardware Switch Settings SWO0: GND v

Shunt Full-Scale Differential Range ADCRANGE: +/-81.94 mV v

Shunt/Current Configuration

RSHUNT: | 2 ‘ mQ

Max Expected Current: ‘ ‘ A

CURRENT_LSB: 0.001 |A

SHUNT_CAL: (2560 |

True CURRENT_LSB: 0.00 A

True Max Current: 32.768 A

Required Sensing Range: 65.5 mV

Figure 4-10. Configuration Tool
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From this page you can set the number of EVMs you are using, and then for each EVM you can indicate the
physical hardware switch settings and configure your shunt and CURRENT_LSB. Below is a description of each
option and field on this page:

Number of EVMs
— This setting is used to tell the GUI how many EVMs are connected to the SCB.
— Note, the SCB and GUI only support up to four EVMs at a time with the same device on each EVM.
— Changing this here also changes the same setting in the Results Data tab.
Selected EVM
— This setting indicates which EVM you are currently changing settings for.
— This also selects the EVM that is connected to the Registers page.
Hardware Switch Settings
— Set these settings to match the physical switch settings on the EVM.
— Note, this setting must be set before changing any other settings on this page. The GUI will block the
other settings until this is set.
— Changing this here also changes the same setting in the Results Data tab.
Shunt Full-Scale Differential Range
— This is a shortcut to the ADCRANGE (ZOOM) setting from the Registers page, placed here for
convenience.
— Both this setting and the ADCRANGE setting from the Registers page change together.
Shunt/Current Configuration
— This section is used to input shunt information as well as to help calculate the CURRENT _LSB and set the
SHUNT _CAL register. Here is a description of how to use each field:
* RSHUNT
— Input the value of the used shunt resister in mQ.
» Max Expected Current
— Input the value of the maximum expected current across the shunt resistor in Amps.
— If the Max Expected Current field is left blank, then SHUNT_CAL can be adjusted manually, and the
tool will tell you the True Max Current that can be measured with the EVM.
+ CURRENT_LSB
— This is the calculated CURRENT _LSB value in Amps. This field gets populated automatically from
the Max Expected Current field.
— This field can be changed manually if desired, and changes will filter downward.
+ SHUNT_CAL
— Calculated value for SHUNT _CAL based off of RSHUNT and CURRENT _LSB. When this field
changes, the value is automatically written to the SHUNT_CAL register.
— When CURRENT_LSB is specified, changing ADCRANGE will adjust this value automatically per
data sheet equations.
» This will happen if ADCRANGE is changed from either the configuration page or the register
map.
+ If CURRENT_LSB is not specified, this value will remain unchanged, but the fields below will
adjust to the new ADCRANGE.
— This field can be changed manually if desired, and changes will filter downward.
— Changing this value from the Registers page also changes it here.
* True CURRENT_LSB
— This is the actual CURRENT_LSB value in Amps back calculated from the SHUNT _CAL register
with the given shunt resistor value.
— This is the value used for calculations in the Results Data section.
» True Max Current
— This is the maximum measurable current in Amps based off of the VSHUNT and CURRENT
registers, using RSHUNT and the True CURRENT _LSB for calculations.
* Required Sensing Range
— This shows the required sensing range to measure the Max Expected Current with the specified
shunt resistor.
— If a Max Expected Current is not specified, then the True Max Current field will be used instead.
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4.2.2.3 Registers Tab

To view and edit the device registers, click the (Registers) icon on the menu to the left. The Registers tab will
look similar to the one shown in Figure 4-11, depending on the device connected.

Regisiriia Selected BB s

[ ————— [ searchsiede [ srowers

Regiser Name address vaive
15 4 13 12 n 10 9 8 7 6 5 4 3 2 1 0 CONFIG

FieLo View

¥ Configuration

| CONFIG [} 0x00 0x4127 0 0 [ 0 0 1 0 0 1 0 0 1 1 1
CALIBRATION 0x05 0x0A00 0 0 0 1 0 1 0 0 0 0 0 0 0 0 0

ALERT_LIMIT 0x07 0x0000 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
¥ Results

VSHUNT 0x01 OXEBEO

VBUS 0x02 0x0810

POWER 0x03 0x051B

CURRENT 0x04 0xCDBO

v Flags and Alerts
FLAGS_ALERT 0x06 0x0008 0 0 0 0 0 0 0 0

¥ 1D Registers
MANUFACTURE_ID 0x3E 0x5449

DEVICE_ID Ox3F 0xA480

Figure 4-11. Registers Tab

From this page, you can read and write device registers on the EVM. Here are some important notes:

* Use the Selected EVM drop-down menu at the top to choose which device to work with on the register map.
— Note, changing this here also changes the same setting for the Configuration tab.
— Functionally, this button sets the default read/write address in the MCU and then reads all register values
back to update the register map. Note that if data is collected at a high frequency, then this may cause
a minor delay in the data collection. For optimal performance, set the device settings before you start
collecting data.
» By default, all changes are automatically written to the device. If desired, you can change the Immediate
Write setting to Deferred Write to only allow writing when you are ready.
— You can modify writable register values from any of these methods:
» Through the widget settings in the Field View section on the right.
* Changing the Value directly with either hex or decimal values.
» Double-clicking on any individual bit.
« Turning on Auto Read will only update registers in the register map, and not the plots in the Results Data
section.
— Leaving Auto Read on while collecting data for plots can interfere with data collection timing.

» For questions about a register or register bit field, click the @ icon.

— For even more questions about registers, check the data sheet.
* For convenience, register settings can be saved and loaded back later to any device with the same register
map. To do this, go to File > Register Data. (See Figure 4-12.)

File Options Tools Help

’ Program Device... Off v

\J .
# Register Data > B Save register settings

EriNaime AGUIres

B Load register settings

on

Figure 4-12. Save and Load Register Settings
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— Tl recommends to press the Read All Registers button after loading data to update the register map with
the actual device values, in case the loaded registers were not compatible with the connected device.

4.2.2.4 Results Data Tab

To view and collect results data over time, click the (Results Data) icon on the menu to the left. Figure 4-13
shows part of the results data page for reference, which may look different depending on the connected device.

Results to collect/show

VSHUNT
VBUS

| Number of EVMs: 2 EvMs v

|EVM 1 SWOIGND v

[SREZG TNV [] #Samples Only

Delay between samples:

CURRENT 2200/ms, (% Auto Delay
POWER
WARNING:
CURRENT.
EVMs!

|EVM2* SWOI VS v ‘

SAVE ALL PLOTS CLEARALL PLOTS
or 1 or more *Selected EVM  [eaZ 7 NN 7Ny
nfiguration tab.

#Samples:[1000
Changing #Samplee clesrs al plots)

VSHUNT Result

2.50

SAVE PLOT
CLEAR PLOT

Y-Axis Options:

[] Manual Scale
Max
Min

=

N A A [
’\'% oy | ‘\m | ) AV\ /}/ // | ik /\ A fl W\\ /
; ] ¥ ‘

100 200 300 500
Samples (751

Figure 4-13. Results Data Tab

Below is a description of how to use the buttons and settings at the top of the results data page and next to each
plot:

* Results to collect/show
— Use this section to select which register values to collect data for. If a results register is unselected before
the COLLECT DATA button is pressed, then the plot below will be hidden and the EVM will not try to read
this register during the collect cycle (even if the conversion is enabled).
— If you disable one of these settings while the EVM is collecting data, then the plot will not show, but data
will still be collected and the plot will update in the background. Simply reselect to show data.
*  Number of EVMs
— Set the Number of EVMSs drop-down menu to the number of EVMs currently in use.
» See Figure 4-2 for how to attach multiple EVMs together.
» Changing this here also changes the same setting in the Configuration tab.
— The GUI only supports one EVM/device type at a time, up to 4 EVMs total.
— Switch settings
» Use the onboard switch(es) to select a different address/chip select for each EVM.
» Set the switch settings in the GUI to match the setting for each connected EVM.
— EVM 1 will automatically populate with the lowest addressed device unless a setting has already
been selected.
— Changing this here also changes the same setting in the Configuration tab.
» If more than one device is being used, a * symbol will appear next to the selected EVM that is being
used on the register map and configuration tabs.
— Changing the switch settings of any EVM sets that EVM as the selected EVM.
* Collect/Plots settings
— Collect Data
* Press the COLLECT DATA button to start data collection.
* In this mode, the MCU reads and sends the selected result values for each device over a USB BULK
channel. All results from one device are read before moving on to the next device.
— All result values from all EVMs together are considered one "sample set".
» Although you can read and write to other registers through the register map page while collecting data,
it is possible that this adds a delay to the data being collected.
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* Press the STOP COLLECT button to stop collecting data.
— #Samples Only

 If this checkbox is selected, then the GUI will automatically stop collecting data after the number of
samples specified in the #Samples box have been collected.
+ If not selected, the GUI will continue collecting data and only store the most recent #Samples.
— Delay between samples
» Sets the delay between the start of each sample set.
» Desired delay time may not be obtainable if it is set faster than the read loop, which depends on the
number of results being collected, the number of EVMs, and your CPU.
» Although you can read and write to other registers through the register map page while collecting data,
it is possible that this adds a delay to the data being collected.
— Auto Delay
+ Sets delay based on conversion times, averaging, and number of channels being converted.
» If multiple EVMs are being used, the time put in the delay box will be from the EVM with the shortest
calculated delay value.
— Save All Plots
* Press the SAVE ALL PLOTS button to save the data for each currently selected result from the Results
to collect/show section in a spreadsheet.
* Press the SAVE PLOT button next to each plot to save just the data from that plot in a spreadsheet.
— Clear All Plots
* Pressthe CLEAR ALL PLOTS button to clear the data from all plots together.
* Press the CLEAR PLOT button next to each plot to clear the data from just that plot.
— #Samples
» Change the number in this box to change the number of samples shown in each plot.
— Changing this number clears out the plot buffers, so the plots will be cleared on the next read.
— Y-Axis Options
* Manual Scale
— Checking this box will set all EVM results in this plot to the same scale value specified by the Max
and Min fields.
— When this is not selected, each EVM will have an Y-axis scale based on the minimum and
maximum result values of that EVM.
— For the DIETEMP Result, the units can also be toggled between °C and °F.
» This processes the existing data in the plots, and converts new data coming in. If receiving new
data while changing units, it is possible that a datapoint gets missed or duplicated.
+ Max
— The maximum Y-axis value to use for all EVMs in this plot.
— If this field is empty when Manual Scale is selected, then it will auto populate with the maximum
value currently in the plot.
* Min
— The minimum Y-axis value to use for all EVMs in this plot.
— If this field is empty when Manual Scale is selected, then it will auto populate with the minimum
value currently in the plot.

The General Call Start command is issued to trigger a simultaneous start of conversion among multiple devices.
When this button is pressed, all devices will stop and restart a new conversion.
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4.2.3 Current Sensing Operation

The EVM allows the user to either emulate the voltage developed across a sense resistor based on a given set
of system conditions by applying a differential voltage across the IN+ and IN— terminals directly, or to connect
the device inputs to an external shunt. Optionally, a 2512 surface-mount technology (SMT) shunt resistor can be
soldered across the pads of R1, and these inputs can be connected in series with the external system and load
current. There are two terminals each for IN+ (J1 pins 5 and 6) and IN- (J1 pins 3 and 4) for convenience.

4.2.3.1 Without Shunt Resistor

To configure a measurement evaluation without a shunt resistor, follow these steps:

1. Connect a differential voltage across the IN+ and IN— terminals (see Figure 4-14). Note that INA234EVM or
INA236EVM is used for illustration. In screw terminal J1, IN+ and IN- are swapped for the INA232EVM (see
Figure 4-15).

a. If the differential voltage supply is a floating supply, connect a —0.3-V to 48-V common-mode voltage
(leave powered off until finished setting up) to the inputs by connecting the positive lead of the external
voltage source to either the IN+ or IN— terminal. This action effectively raises the absolute common-
mode voltage of the input pins. Make sure that the differential voltage plus or minus the common-mode
voltage within the —0.3-V to 48-V range.

Power Supply 1 Power Supply 2

Lo Hi Lo Hi

® 10A MAX
42UCH MAX

® 10A MAX
48UCM MAX

H " lN_ . .IN+
4
)?a ‘-’ @ l:|

R-£ ._,cz_ g T Hie
)22 ALERT C1 U1

Figure 4-15. INA232EVM

1. Connect the VBUS terminal (J1 pin 2) to the desired bus voltage (likely either IN+ or IN-).
2. Connect the source ground to the GND terminal (J1 pin 1).
3. Power on the system, and observe the device states and outputs through the GUI.
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4.2.3.2 With Shunt Resistor

To configure a measurement evaluation with a shunt resistor, follow these steps:
1. Connect a shunt resister by doing either of the following:
a. Solder a 2512 resistor across the pads of R1 that connects the IN+ and IN— inputs.
b. Connect an external shunt across the IN+ and IN— terminals of J1, preferably across pins 4 and 5 (see
Figure 4-16).
i. If an external shunt is being used, make the connections such that the sensing location is across
the shunt and there will be no high current on the sensing path. See the T/ Precision Labs - Current
Sense Amplifiers: Shunt Resistor Layout video for more information.
2. Connect the IN+ and IN- terminals in series with the load while powered off.

Load Current Line IN+ Load Current Line IN-

® 10A MAX
42UCH MAX

)as

son [1] E8
)8 RLERT _ SCL-Ell]

L

oc
oo
Sa

SENSO?S&

Figure 4-16. IN+ and IN- Wiring With a Shunt Resistor

WARNING

If measuring current, first make sure that the equipment (shunt resistor, wires, connectors, and
so on) can support the amperage and power dissipation. Secondly, make sure that the current
flowing through J1 does not exceed 10 A. Failure to do so can result in damage to the EVM, or
personal injury.

Do not touch high voltage terminals.

The EVM may get hot.

3. Connect the VBUS terminal (J1 pin 2) to the desired bus voltage (likely either IN+ or IN-).
4. Connect the system ground to the GND terminal (J1 pin 1).

5. Power on the system, and observe the device states and outputs through the GUI.
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4.2.4 Direct EVM USB Communication

If desired, the EVM can be communicated with directly without the use of the GUI through the USB port. This is
done by sending the desired command string over the serial COM port and receiving the results either through
the COM port or the USB BULK channel, based on the mode. This is useful for interfacing the EVM with custom
setups, scripts, or GUIs.

4.2.4.1 Standard USB CDC Read and Write Operations

Use the serial COM port to read and write registers through USB CDC commands using the following format:
* Read register format: rreg ADR
— Where ADR is the address in hex, and rreg is always lower case
— Register addresses can be in upper or lower case, and do not need to be led by '0x'. 0 padding register
addresses is also optional. For example, to read register address 0x1, some valid commands include:

* rreg 1
* rreg 01
* rreg 0x01

— When '0x' is used, the 'x' must be lower case.
— For the previous example, the EVM would return the results in JSON format

{"acknowledge":"rreg 0x01"}
{"register":{"address":1,:"value":3}}

{"evm_state":"idle"}
»  Write register format: wreg ADR VAL

— Where ADR and VAL are in hex, and wreg is always lower case

— Register addresses and values can be in upper or lower case, and do not need to be led by '0Ox'. 0 padding
register addresses and values is also optional. For example, to write register address 0x5 with the value
0x4121, some valid commands include:
* wreg 54121
* wreg 05 0x4121
* wreg 0x05 0x4121

— When '0x' is used, the 'x' must be lower case.
— For the previous example, the EVM would return the results in JSON format:

{"acknowledge":"wreg 0x01 0x4121"}
{"console":"Writing 0x4121 to ADC_CONFIG register"}

{"evm_state":"idle"}
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4.2.4.2 Collect Data Through the USB BULK Channel

The Collect Data function can also be started and stopped through the serial COM port, however the results will
be sent over the USB BULK Channel. To do this, use the following format:

» Start collecting data format: collect timerPeriod collectFlags channelAddressIDs numDevices
— Where each parameter is the decimal representation of the value in the following format:

timerPeriod: The delay used in the internal timer to allow data collection sample sets (in milliseconds,
unsigned 32-bit value).
collectFlags: a byte of data that has a 1 to collect and a 0 to not collect each register value type,
according to the following definitions (note to only use energy and charge flags when the device
supports that, otherwise set to 0):
— VSHUNT = 0b1000000
— VBUS = 0b0100000
— CURRENT = 0b0001000
— POWER = 0b0000100
channelAddressIDs
— This is the 4 LSBs of each address chained together, starting with the LSBs.
* For example If EVM 1 is on channel 0x41 and EVM 2 is on 0x43, the value here would be
0b00110001
NumDevices is the number of EVMs chained together (1-4).

— For example, to start data collection for VSHUNT, VBUS, and CURRENT and POWER every 10 ms, for
four INA236s with EVM 1 SW0 = GND, EVM 2 SWO0 = VS, EVM 3 SW0 = SDA and EVM 4 SW0 = SCL,
you would send: collect 10 108 12816 4

For this example, the EVM would return the acknowledgment and status in JSON format:
{"acknowledge":"collect 10 108 12816 4"}

{"evm_state":"collecting"}
Note, for the rreg and wreg functions above, the EVM will return "collecting" instead of "idle" if
collecting.

— The USB BULK channel receives data in the format: framelD deviceNumID address registerSize data

Where each parameter is the decimal representation of the value in the following format:
— framelD (1 byte): Always reads 0. Used to ensure data is aligned.
— deviceNumiID (1 byte): An ID number corresponding to the EVM number.
» From the above example, this will be 1 if reading from EVM 1, 2 from EVM 2, 3 from EVM 3, and
4 from EVM 4.
— address (1 byte): The register address that was read from the device.
— registerSize (1 byte): The number of bytes that the following data will have.
— data (1 byte at a time): The register data value, given in bytes with the most significant byte first.

» Stop collecting data format: stop
— The EVM would return the acknowledgment and status in JSON format:

{"acknowledge":"stop"}

{"evm_state":"idle"}

18 INA232EVM, INA234EVM and INA236EVM SBOU264B — MAY 2021 — REVISED DECEMBER 2022

Submit Document Feedback
Copyright © 2022 Texas Instruments Incorporated


https://www.ti.com
https://www.ti.com/lit/pdf/SBOU264
https://www.ti.com/feedbackform/techdocfeedback?litnum=SBOU264B&partnum=INA234EVM

13 TEXAS
INSTRUMENTS

www.ti.com Circuitry

5 Circuitry

This section summarizes the EVM subsystems and their components.
5.1 Current Sensing IC

This section describes the main INA device and supporting components.

U1 is the main INA current-sensing device (either the INA232, INA234, or INA236). C1 and C2 are bypass
capacitors that are placed near the sensor to help mitigate power supply noise and provide current quickly to the
device when needed. LED D1 with current limiting resistor R4 are used to indicate when the EVM is powered on.

The device pins can be monitored directly through the test points.
5.2 Input Signal Path
This section describes the circuitry of the input signal path.

J1 is the main connection terminal. Pin 1 of J1 is used to tie the system ground to the EVM ground. Pin 2 of J1
is used for the VBUS measurement within the sensor. Pins 3 and 4 are tied to IN—, and Pins 5 and 6 are tied to
IN+. There are two pins each for IN— and IN+ for convenience.

R1 can be used for an optional onboard shunt resistor with a 2512 footprint. Alternatively, a shunt can be placed
across the IN+ and IN— terminals of J1. If desired, a differential voltage can be applied directly for measurement
tests.

C3, R2, and R3 combine to make an optional input filter. R2 and R3 are populated with 0-Q resistors by default.
When using input filtering, take into account the input bias current of the device.

5.3 Digital Circuitry
This section describes the digital circuitry around the device.
5.3.112C

J2 and J3 are the main header pins that connect the digital and power pins to the SCB Controller or other EVMs.
J3 connects to the EVM/SCB on the right, while J2 connects to more EVMs on the left. R5 and R6 are used as
pullup resistors for the main digital 10 pins.

SWO sets the 12C address of the device. This can be useful when using the EVM with a custom controller (other
than the SCB Controller), or when connecting multiple EVMs together. Currently the SCB Controller and GUI are
set up to use four EVMs at a time.

R8 is used as a pullup resistor for the ALERT pin, which is routed to both J2 and J3. LED D2 and current limiting
resistor R7 are used to indicate when the ALERT has triggered.
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6 Schematics, PCB Layout, and Bill of Materials

Note

Board layouts are not to scale. These figures are intended to show how the board is laid out. The

figures are not intended to be used for manufacturing EVM PCBs.

6.1 Schematics

This section shows the schematics for the INA23x EVMs. The schematics are identical except for the IC itself.
6.1.1 SENS079 (INA234EVM, INA236EVM)

Figure 6-1 and Figure 6-2 show the schematics of the SENS079 variant (INA234EVM and INA236EVM). Figure
6-1 shows the circuitry for these EVMs, and Figure 6-2 shows the mechanical components included with the

EVMs.
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Figure 6-1. SENS079 Schematic
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Figure 6-2. SENS079 Hardware Schematic
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6.1.2 SENS090 (INA232EVM)
Figure 6-3 shows the schematic of the SENS090 variant (INA232EVM).
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Figure 6-3. SENS090 Schematic
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6.2 PCB Layout
6.2.1 SENS079 (INA234EVM, INA236EVM)

This section shows the PCB layers of the SENS079 variant (INA234EVM and INA236EVM).
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Figure 6-4. SENS079 Top View
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6.2.2 SENS090 (INA232EVM)
This section shows the PCB layers of the SENS090 variant (INA232EVM).
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Figure 6-8. SENS090 Top View Figure 6-9. SENS090 Top Layer
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Figure 6-10. SENS090 Bottom View Figure 6-11. SENS090 Bottom Layer
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6.3 Bill of Materials
This section shows the bill of materials for the INA23xEVM.
6.3.1 SENS079 (INA234EVM, INA236EVM)

Table 6-1 through Table 6-3 provide the parts list for the INA234EVM and INA236EVMs. Table 6-1 through Table 6-2 are variant specific, while Table 6-3

shows the parts common to both SENS079 variants.

Table 6-1. INA234EVM Exclusive Bill of Materials
Designator |QTY | Value Description Package Reference Part Number Manufacturer
U1 1 28-V, 12-Bit, 12C Output Current, Voltage, and Power Monitor DSBGAS8 INA234AIYBJR Texas Instruments
Table 6-2. INA236VM Exclusive Bill of Materials
Designator | QTY | Value Description Package Reference Part Number Manufacturer
U1 1 42-V, 16-Bit, Precision 12C Output Current, Voltage, and Power Monitor DSBGAS8 INA236AIYBJR Texas Instruments
Table 6-3. SENS079 Variants Bill of Materials
Designator | QTY | Value Description Package Reference Part Number Manufacturer
IPCB1 1 Printed Circuit Board SENS079 Any
C1 1 1uF  |CAP, CERM, 1 pF, 16 V,+/- 20%, X5R, 0402 0402 C1005X6S1C105K050BC TDK
Cc2 1 0.1uF | CAP, CERM, 0.1 uF, 50V, +/- 20%, X7R, 0402 0402 GRM155R71H104ME14D MuRata
D1, D2 2 White |LED, White, SMD 0805 VAOL-S8WR4 Visual Communications
Company, LLC
H1, H2, H3, 4 Bumpon, Hemisphere, 0.25 X 0.075, Clear 75x250 mil SJ5382 3M
H4
J1 1 TERM BLK 6POS SIDE ENTRY 5MM PCBASSEMBLY NOTE: Trim leads per ZZ5 HDR6 691137710006 Waurth Electronics
J2 1 Receptacle, 2mm, 6x2, Gold, R/A, TH Receptacle, 2mm, 6x2, R/A, |NPPN062FJFN-RC Sullins Connector Solutions
TH
J3 1 'Connector Header Through Hole, Right Angle 12 position 0.079" (2.00mm) HDR12 NRPNO062PARN-RC Sullins Connector Solutions
LBL1 1 Thermal Transfer Printable Labels, 0.650" W x 0.200" H - 10,000 per roll PCB Label 0.650 x 0.200 inch | THT-14-423-10 Brady
R2, R3 2 0 RES, 0, 5%, 0.125 W, 0603 0603 MCT06030Z0000ZP500 Vishay/Beyschlag
R4, R7 2 10k |RES, 10 k, 5%, 0.063 W, AEC-Q200 Grade 0, 0402 0402 CRCWO040210K0JNED Vishay-Dale
R5, R6, R8 3 4.7k |RES, 4.7 k, 5%, 0.063 W, AEC-Q200 Grade 0, 0402 0402 CRCWO04024K70JNED Vishay-Dale
SWo 1 Slide Switch SP4T Surface Mount, Right Angle SMT_SW_11MM3_4MMA1 CUS-14TB Nidec Copal Electronics
TP2, TP3, 8 Test Point, Miniature, SMT Testpoint_Keystone_Miniatur | 5015 Keystone
TP4, TP5, e
TP7, TP8,
TP10, TP11,
C3 0 0.1uF | CAP, CERM, 0.1 uF, 100 V, +/- 10%, X7S, AEC-Q200 Grade 1, 0603 0603 CGA3E3X7S2A104K080AB | TDK
FID1, FID2, 0 Fiducial mark. There is nothing to buy or mount. N/A N/A N/A
FID3
R1 0 10 mOhms +0.5% 2W Chip Resistor 2512 (6432 Metric) Automotive AEC-Q200, 2512 PCS2512DR0O100ET Ohmite
Current Sense, Moisture Resistant Metal Film
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6.3.2 SENS090 (INA232EVM)
Table 6-4 shows the parts common to both SENS090 variants.
Table 6-4. SENS090 Variants Bill of Materials
Designator | QTY | Value Description Package Reference Part Number Manufacturer
IPCB1 1 Printed Circuit Board SENSO079 Any
C1 1 1uF | CAP, CERM, 1 pF, 16 V,+/- 20%, X5R, 0402 0402 C1005X6S1C105K050BC TDK
c2 1 0.1uF | CAP, CERM, 0.1 uF, 50 V, +/- 20%, X7R, 0402 0402 GRM155R71H104ME 14D MuRata
D1, D2 2 White |LED, White, SMD 0805 VAOL-S8WR4 Visual Communications
Company, LLC
H1, H2, H3, 4 Bumpon, Hemisphere, 0.25 X 0.075, Clear 75x250 mil SJ5382 3M
H4
J1 1 TERM BLK 6POS SIDE ENTRY 5MM PCBASSEMBLY NOTE: Trim leads per ZZ5 HDR6 691137710006 Waurth Electronics
J2 1 Receptacle, 2mm, 6x2, Gold, R/A, TH _}?ﬁceptacle, 2mm, 6x2, R/A, |NPPNO062FJFN-RC Sullins Connector Solutions
J3 1 'Connector Header Through Hole, Right Angle 12 position 0.079" (2.00mm) HDR12 NRPNO62PARN-RC Sullins Connector Solutions
J4 1 Header, 2.54 mm, 2x1, Gold, TH Header, 2.54mm, 2x1, TH 61300211121 Wurth Elektronik
LBL1 1 Thermal Transfer Printable Labels, 0.650" W x 0.200" H - 10,000 per roll PCB Label 0.650 x 0.200 inch | THT-14-423-10 Brady
R2, R3 2 0 RES, 0, 5%, 0.125 W, 0603 0603 MCT06030Z0000ZP500 Vishay/Beyschlag
R4, R7 2 10k |RES, 10 k, 5%, 0.063 W, AEC-Q200 Grade 0, 0402 0402 CRCWO040210K0JNED Vishay-Dale
R5, R6, R8 3 4.7k |RES, 4.7 k, 5%, 0.063 W, AEC-Q200 Grade 0, 0402 0402 CRCWO04024K70JNED Vishay-Dale
SH-J4 1 Shunt, 2.54mm, Gold, Black Shunt, 2.54mm, Black 60900213421 Wurth Elektronik
SW0 1 Slide Switch SP4T Surface Mount, Right Angle SMT_SW_11MM3_4MM1 CUS-14TB Nidec Copal Electronics
TP2, TP3, 8 Test Point, Miniature, SMT Testpoint_Keystone_Miniatur | 5015 Keystone
TP4, TP5, e
TP7, TP8,
TP10, TP11,
U1 1 48-V, 16-Bit, Current, Voltage, and Power Monitor With an 12C Interface SOT23-8 INA232AIDDFR Texas Instruments
C3 0 0.1uF | CAP, CERM, 0.1 uF, 100 V, +/- 10%, X7S, AEC-Q200 Grade 1, 0603 0603 CGA3E3X7S2A104K080AB | TDK
FID1, FID2, 0 Fiducial mark. There is nothing to buy or mount. N/A N/A N/A
FID3
R1 0 10 mOhms +0.5% 2W Chip Resistor 2512 (6432 Metric) Automotive AEC-Q200, 2512 PCS2512DRO100ET Ohmite
Current Sense, Moisture Resistant Metal Film
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STANDARD TERMS FOR EVALUATION MODULES

Delivery: Tl delivers Tl evaluation boards, kits, or modules, including any accompanying demonstration software, components, and/or
documentation which may be provided together or separately (collectively, an “EVM” or “EVMs”) to the User (“User”) in accordance
with the terms set forth herein. User's acceptance of the EVM is expressly subject to the following terms.

11

1.2

EVMs are intended solely for product or software developers for use in a research and development setting to facilitate feasibility
evaluation, experimentation, or scientific analysis of Tl semiconductors products. EVMs have no direct function and are not
finished products. EVMs shall not be directly or indirectly assembled as a part or subassembly in any finished product. For
clarification, any software or software tools provided with the EVM (“Software”) shall not be subject to the terms and conditions
set forth herein but rather shall be subject to the applicable terms that accompany such Software

EVMs are not intended for consumer or household use. EVMs may not be sold, sublicensed, leased, rented, loaned, assigned,
or otherwise distributed for commercial purposes by Users, in whole or in part, or used in any finished product or production
system.

Limited Warranty and Related Remedies/Disclaimers:

21

2.2

2.3

These terms do not apply to Software. The warranty, if any, for Software is covered in the applicable Software License
Agreement.

Tl warrants that the TI EVM will conform to TI's published specifications for ninety (90) days after the date Tl delivers such EVM
to User. Notwithstanding the foregoing, Tl shall not be liable for a nonconforming EVM if (a) the nonconformity was caused by
neglect, misuse or mistreatment by an entity other than TI, including improper installation or testing, or for any EVMs that have
been altered or modified in any way by an entity other than TI, (b) the nonconformity resulted from User's design, specifications
or instructions for such EVMs or improper system design, or (¢) User has not paid on time. Testing and other quality control
technigues are used to the extent Tl deems necessary. Tl does not test all parameters of each EVM.
User's claims against Tl under this Section 2 are void if User fails to notify Tl of any apparent defects in the EVMs within ten (10)
business days after delivery, or of any hidden defects with ten (10) business days after the defect has been detected.

TI's sole liability shall be at its option to repair or replace EVMs that fail to conform to the warranty set forth above, or credit
User's account for such EVM. TI's liability under this warranty shall be limited to EVMs that are returned during the warranty
period to the address designated by Tl and that are determined by TI not to conform to such warranty. If Tl elects to repair or
replace such EVM, Tl shall have a reasonable time to repair such EVM or provide replacements. Repaired EVMs shall be
warranted for the remainder of the original warranty period. Replaced EVMs shall be warranted for a new full ninety (90) day
warranty period.

WARNING

Evaluation Kits are intended solely for use by technically qualified,
professional electronics experts who are familiar with the dangers
and application risks associated with handling electrical mechanical
components, systems, and subsystems.

User shall operate the Evaluation Kit within TI's recommended
guidelines and any applicable legal or environmental requirements
as well as reasonable and customary safeguards. Failure to set up

and/or operate the Evaluation Kit within TI's recommended
guidelines may result in personal injury or death or property
damage. Proper set up entails following TI's instructions for
electrical ratings of interface circuits such as input, output and
electrical loads.

NOTE:

EXPOSURE TO ELECTROSTATIC DISCHARGE (ESD) MAY CAUSE DEGREDATION OR FAILURE OF THE EVALUATION
KIT; TI RECOMMENDS STORAGE OF THE EVALUATION KIT IN A PROTECTIVE ESD BAG.
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3

Regulatory Notices:

3.1

3.2

United States
3.1.1 Notice applicable to EVMs not FCC-Approved:

FCC NOTICE: This kit is designed to allow product developers to evaluate electronic components, circuitry, or software
associated with the kit to determine whether to incorporate such items in a finished product and software developers to write
software applications for use with the end product. This kit is not a finished product and when assembled may not be resold or
otherwise marketed unless all required FCC equipment authorizations are first obtained. Operation is subject to the condition
that this product not cause harmful interference to licensed radio stations and that this product accept harmful interference.
Unless the assembled kit is designed to operate under part 15, part 18 or part 95 of this chapter, the operator of the kit must
operate under the authority of an FCC license holder or must secure an experimental authorization under part 5 of this chapter.

3.1.2 For EVMs annotated as FCC — FEDERAL COMMUNICATIONS COMMISSION Part 15 Compliant:

CAUTION

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.

Changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to
operate the equipment.

FCC Interference Statement for Class A EVM devices

NOTE: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is
operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not
installed and used in accordance with the instruction manual, may cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to
correct the interference at his own expense.

FCC Interference Statement for Class B EVM devices

NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance
with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more
of the following measures:

« Reorient or relocate the receiving antenna.

« Increase the separation between the equipment and receiver.

« Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
« Consult the dealer or an experienced radio/TV technician for help.

Canada
3.2.1 For EVMs issued with an Industry Canada Certificate of Conformance to RSS-210 or RSS-247
Concerning EVMs Including Radio Transmitters:
This device complies with Industry Canada license-exempt RSSs. Operation is subject to the following two conditions:

(1) this device may not cause interference, and (2) this device must accept any interference, including interference that may
cause undesired operation of the device.

Concernant les EVMs avec appareils radio:

Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts de licence. L'exploitation
est autorisée aux deux conditions suivantes: (1) I'appareil ne doit pas produire de brouillage, et (2) l'utilisateur de I'appareil doit
accepter tout brouillage radioélectrique subi, méme si le brouillage est susceptible d'en compromettre le fonctionnement.

Concerning EVMs Including Detachable Antennas:

Under Industry Canada regulations, this radio transmitter may only operate using an antenna of a type and maximum (or lesser)
gain approved for the transmitter by Industry Canada. To reduce potential radio interference to other users, the antenna type
and its gain should be so chosen that the equivalent isotropically radiated power (e.i.r.p.) is not more than that necessary for
successful communication. This radio transmitter has been approved by Industry Canada to operate with the antenna types
listed in the user guide with the maximum permissible gain and required antenna impedance for each antenna type indicated.
Antenna types not included in this list, having a gain greater than the maximum gain indicated for that type, are strictly prohibited
for use with this device.
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3.3

Concernant les EVMs avec antennes détachables

Conformément a la réglementation d'Industrie Canada, le présent émetteur radio peut fonctionner avec une antenne d'un type et
d'un gain maximal (ou inférieur) approuvé pour I'émetteur par Industrie Canada. Dans le but de réduire les risques de brouillage
radioélectrique a l'intention des autres utilisateurs, il faut choisir le type d'antenne et son gain de sorte que la puissance isotrope
rayonnée équivalente (p.i.r.e.) ne dépasse pas lintensité nécessaire a I'établissement d'une communication satisfaisante. Le
présent émetteur radio a été approuvé par Industrie Canada pour fonctionner avec les types d'antenne énumérés dans le
manuel d'usage et ayant un gain admissible maximal et lI'impédance requise pour chaque type d'antenne. Les types d'antenne
non inclus dans cette liste, ou dont le gain est supérieur au gain maximal indiqué, sont strictement interdits pour I'exploitation de
I'émetteur
Japan
3.3.1 Notice for EVMs delivered in Japan: Please see http://www.tij.co.jp/Isds/ti_ja/general/eStore/notice_01.page HZAEMAIC
BAThBEAETY M, R—RIZDOVTRE, ROEZHEZEBIEEL,
http://www_tij.co.jp/Isds/ti_ja/general/eStore/notice_01.page

3.3.2 Notice for Users of EVMs Considered “Radio Frequency Products” in Japan: EVMs entering Japan may not be certified
by Tl as conforming to Technical Regulations of Radio Law of Japan.

If User uses EVMs in Japan, not certified to Technical Regulations of Radio Law of Japan, User is required to follow the
instructions set forth by Radio Law of Japan, which includes, but is not limited to, the instructions below with respect to EVMs
(which for the avoidance of doubt are stated strictly for convenience and should be verified by User):

1. Use EVMs in a shielded room or any other test facility as defined in the notification #173 issued by Ministry of Internal
Affairs and Communications on March 28, 2006, based on Sub-section 1.1 of Article 6 of the Ministry’s Rule for
Enforcement of Radio Law of Japan,

2. Use EVMs only after User obtains the license of Test Radio Station as provided in Radio Law of Japan with respect to
EVMs, or

3. Use of EVMs only after User obtains the Technical Regulations Conformity Certification as provided in Radio Law of Japan
with respect to EVMs. Also, do not transfer EVMs, unless User gives the same notice above to the transferee. Please note
that if User does not follow the instructions above, User will be subject to penalties of Radio Law of Japan.

[BRERZEEITIHAORAFTY FESEVICEIBROIESHE] BRTY NORICEEMEEBESGTERAZRZTT

WBEVWEDABYET, BEMERIHZZHTTVEVEOOIFALCEBL TR, BREAEFOLD, UTOVThAID

BEZH > TVEEKMBENGHWERTOTIEESLEE L,

1. ?;‘fi%bfﬁiﬁﬂﬂﬁ6§%llﬁﬁl%tgﬁ <FRISFIA2BAMBEE RELIBS TED SN ERBELZOEBRIBTIMEA

2. RRROKFEMERIFEAVELEL,

3. HEEBHAMPHEMBEIEAVEEL,

BE, AEAE., O TTHEACHLEOTOER, ZBEL. BEACEALZVRY, BE, BETERZLVEOELET,
tiRZEBFEFEVEERE. EREDCARNIERAEC ARSI H2 L Z2IERB<LEEV, BETHFYR

PAYNX Y HA LM

REBHMEXEHMBCOTE24&E 15

EHBE=HEIL

3.3.3 Notice for EVMs for Power Line Communication: Please see http://www.tij.co.jp/Isds/ti_ja/general/eStore/notice_02.page

ENBRMERBECOVTOBERTY REBEVICEIBOEEBEICOVTR, ROEIBREIBEBSEEV, hitp/
/www.tij.co.jp/Isds/ti_ja/general/eStore/notice_02.page

3.4 European Union

3.4.1 For EVMs subject to EU Directive 2014/30/EU (Electromagnetic Compatibility Directive):

This is a class A product intended for use in environments other than domestic environments that are connected to a
low-voltage power-supply network that supplies buildings used for domestic purposes. In a domestic environment this
product may cause radio interference in which case the user may be required to take adequate measures.
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4 EVM Use Restrictions and Warnings:

4.1 EVMS ARE NOT FOR USE IN FUNCTIONAL SAFETY AND/OR SAFETY CRITICAL EVALUATIONS, INCLUDING BUT NOT
LIMITED TO EVALUATIONS OF LIFE SUPPORT APPLICATIONS.

4.2 User must read and apply the user guide and other available documentation provided by Tl regarding the EVM prior to handling
or using the EVM, including without limitation any warning or restriction notices. The notices contain important safety information
related to, for example, temperatures and voltages.

4.3 Safety-Related Warnings and Restrictions:

4.3.1 User shall operate the EVM within TI's recommended specifications and environmental considerations stated in the user
guide, other available documentation provided by TI, and any other applicable requirements and employ reasonable and
customary safeguards. Exceeding the specified performance ratings and specifications (including but not limited to input
and output voltage, current, power, and environmental ranges) for the EVM may cause personal injury or death, or
property damage. If there are questions concerning performance ratings and specifications, User should contact a Tl
field representative prior to connecting interface electronics including input power and intended loads. Any loads applied
outside of the specified output range may also result in unintended and/or inaccurate operation and/or possible
permanent damage to the EVM and/or interface electronics. Please consult the EVM user guide prior to connecting any
load to the EVM output. If there is uncertainty as to the load specification, please contact a Tl field representative.
During normal operation, even with the inputs and outputs kept within the specified allowable ranges, some circuit
components may have elevated case temperatures. These components include but are not limited to linear regulators,
switching transistors, pass transistors, current sense resistors, and heat sinks, which can be identified using the
information in the associated documentation. When working with the EVM, please be aware that the EVM may become
very warm.

4.3.2 EVMs are intended solely for use by technically qualified, professional electronics experts who are familiar with the
dangers and application risks associated with handling electrical mechanical components, systems, and subsystems.
User assumes all responsibility and liability for proper and safe handling and use of the EVM by User or its employees,
affiliates, contractors or designees. User assumes all responsibility and liability to ensure that any interfaces (electronic
and/or mechanical) between the EVM and any human body are designed with suitable isolation and means to safely
limit accessible leakage currents to minimize the risk of electrical shock hazard. User assumes all responsibility and
liability for any improper or unsafe handling or use of the EVM by User or its employees, affiliates, contractors or
designees.

4.4 User assumes all responsibility and liability to determine whether the EVM is subject to any applicable international, federal,
state, or local laws and regulations related to User's handling and use of the EVM and, if applicable, User assumes all
responsibility and liability for compliance in all respects with such laws and regulations. User assumes all responsibility and
liability for proper disposal and recycling of the EVM consistent with all applicable international, federal, state, and local
requirements.

5. Accuracy of Information: To the extent Tl provides information on the availability and function of EVMs, Tl attempts to be as accurate
as possible. However, Tl does not warrant the accuracy of EVM descriptions, EVM availability or other information on its websites as
accurate, complete, reliable, current, or error-free.

6. Disclaimers:

6.1 EXCEPT AS SET FORTH ABOVE, EVMS AND ANY MATERIALS PROVIDED WITH THE EVM (INCLUDING, BUT NOT
LIMITED TO, REFERENCE DESIGNS AND THE DESIGN OF THE EVM ITSELF) ARE PROVIDED "AS IS" AND "WITH ALL
FAULTS." Tl DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, REGARDING SUCH ITEMS, INCLUDING BUT
NOT LIMITED TO ANY EPIDEMIC FAILURE WARRANTY OR IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF ANY THIRD PARTY PATENTS, COPYRIGHTS, TRADE
SECRETS OR OTHER INTELLECTUAL PROPERTY RIGHTS.

6.2 EXCEPT FOR THE LIMITED RIGHT TO USE THE EVM SET FORTH HEREIN, NOTHING IN THESE TERMS SHALL BE
CONSTRUED AS GRANTING OR CONFERRING ANY RIGHTS BY LICENSE, PATENT, OR ANY OTHER INDUSTRIAL OR
INTELLECTUAL PROPERTY RIGHT OF TI, ITS SUPPLIERS/LICENSORS OR ANY OTHER THIRD PARTY, TO USE THE
EVM IN ANY FINISHED END-USER OR READY-TO-USE FINAL PRODUCT, OR FOR ANY INVENTION, DISCOVERY OR
IMPROVEMENT, REGARDLESS OF WHEN MADE, CONCEIVED OR ACQUIRED.

7. USER'S INDEMNITY OBLIGATIONS AND REPRESENTATIONS. USER WILL DEFEND, INDEMNIFY AND HOLD TI, ITS
LICENSORS AND THEIR REPRESENTATIVES HARMLESS FROM AND AGAINST ANY AND ALL CLAIMS, DAMAGES, LOSSES,
EXPENSES, COSTS AND LIABILITIES (COLLECTIVELY, "CLAIMS") ARISING OUT OF OR IN CONNECTION WITH ANY
HANDLING OR USE OF THE EVM THAT IS NOT IN ACCORDANCE WITH THESE TERMS. THIS OBLIGATION SHALL APPLY
WHETHER CLAIMS ARISE UNDER STATUTE, REGULATION, OR THE LAW OF TORT, CONTRACT OR ANY OTHER LEGAL
THEORY, AND EVEN IF THE EVM FAILS TO PERFORM AS DESCRIBED OR EXPECTED.
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8.

10.

Limitations on Damages and Liability:

8.1

8.2

General Limitations. IN NO EVENT SHALL Tl BE LIABLE FOR ANY SPECIAL, COLLATERAL, INDIRECT, PUNITIVE,
INCIDENTAL, CONSEQUENTIAL, OR EXEMPLARY DAMAGES IN CONNECTION WITH OR ARISING OUT OF THESE
TERMS OR THE USE OF THE EVMS , REGARDLESS OF WHETHER Tl HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES. EXCLUDED DAMAGES INCLUDE, BUT ARE NOT LIMITED TO, COST OF REMOVAL OR
REINSTALLATION, ANCILLARY COSTS TO THE PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES, RETESTING,
OUTSIDE COMPUTER TIME, LABOR COSTS, LOSS OF GOODWILL, LOSS OF PROFITS, LOSS OF SAVINGS, LOSS OF
USE, LOSS OF DATA, OR BUSINESS INTERRUPTION. NO CLAIM, SUIT OR ACTION SHALL BE BROUGHT AGAINST TI
MORE THAN TWELVE (12) MONTHS AFTER THE EVENT THAT GAVE RISE TO THE CAUSE OF ACTION HAS
OCCURRED.

Specific Limitations. IN NO EVENT SHALL TI'S AGGREGATE LIABILITY FROM ANY USE OF AN EVM PROVIDED
HEREUNDER, INCLUDING FROM ANY WARRANTY, INDEMITY OR OTHER OBLIGATION ARISING OUT OF OR IN
CONNECTION WITH THESE TERMS, , EXCEED THE TOTAL AMOUNT PAID TO Tl BY USER FOR THE PARTICULAR
EVM(S) AT ISSUE DURING THE PRIOR TWELVE (12) MONTHS WITH RESPECT TO WHICH LOSSES OR DAMAGES ARE
CLAIMED. THE EXISTENCE OF MORE THAN ONE CLAIM SHALL NOT ENLARGE OR EXTEND THIS LIMIT.

Return Policy. Except as otherwise provided, Tl does not offer any refunds, returns, or exchanges. Furthermore, no return of EVM(s)

will be accepted if the package has been opened and no return of the EVM(s) will be accepted if they are damaged or otherwise not in
a resalable condition. If User feels it has been incorrectly charged for the EVM(s) it ordered or that delivery violates the applicable
order, User should contact TI. All refunds will be made in full within thirty (30) working days from the return of the components(s),
excluding any postage or packaging costs.

Governing Law: These terms and conditions shall be governed by and interpreted in accordance with the laws of the State of Texas,
without reference to conflict-of-laws principles. User agrees that non-exclusive jurisdiction for any dispute arising out of or relating to
these terms and conditions lies within courts located in the State of Texas and consents to venue in Dallas County, Texas.
Notwithstanding the foregoing, any judgment may be enforced in any United States or foreign court, and Tl may seek injunctive relief
in any United States or foreign court.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2019, Texas Instruments Incorporated
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IMPORTANT NOTICE AND DISCLAIMER

TI PROVIDES TECHNICAL AND RELIABILITY DATA (INCLUDING DATA SHEETS), DESIGN RESOURCES (INCLUDING REFERENCE
DESIGNS), APPLICATION OR OTHER DESIGN ADVICE, WEB TOOLS, SAFETY INFORMATION, AND OTHER RESOURCES “AS IS”
AND WITH ALL FAULTS, AND DISCLAIMS ALL WARRANTIES, EXPRESS AND IMPLIED, INCLUDING WITHOUT LIMITATION ANY
IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF THIRD
PARTY INTELLECTUAL PROPERTY RIGHTS.

These resources are intended for skilled developers designing with Tl products. You are solely responsible for (1) selecting the appropriate
TI products for your application, (2) designing, validating and testing your application, and (3) ensuring your application meets applicable
standards, and any other safety, security, regulatory or other requirements.

These resources are subject to change without notice. Tl grants you permission to use these resources only for development of an
application that uses the Tl products described in the resource. Other reproduction and display of these resources is prohibited. No license
is granted to any other Tl intellectual property right or to any third party intellectual property right. Tl disclaims responsibility for, and you
will fully indemnify Tl and its representatives against, any claims, damages, costs, losses, and liabilities arising out of your use of these
resources.

TI's products are provided subject to TI's Terms of Sale or other applicable terms available either on ti.com or provided in conjunction with
such Tl products. TI's provision of these resources does not expand or otherwise alter TI's applicable warranties or warranty disclaimers for
TI products.

Tl objects to and rejects any additional or different terms you may have proposed.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2022, Texas Instruments Incorporated
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